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Kegiatan Pembelajaran 1 

Statistika Deskriptif Dasar 

A. Tujuan 

Setelah mempelajari materi ini, peserta diklat dapat memahami cara 

mengolah dan menyajikan data statistik deskriptif menggunakan program  

pengolah data atau aplikasi statistika untuk membantu kegiatan 

pengembangan diri dan aktivitas profesi.  

B. Indikator Pencapaian Kompetensi 

1. Membedakan statistik deskriptif dan statistik inferensial. 

2. Membedakan jenis-jenis variabel penelitian dan skala pengukuran. 

3. Memahami cara mengolah dan menyajikan data  hasil penelitian sesuai 

karakteristik datanya. 

4. Menggunakan berbagai aplikasi komputer populer untuk mengolah dan 

menyajikan data statistik deskriptif hasil penelitian. 

C. Uraian Materi 

Statistika Deskriptif Vs Statistika Inferensial 

Ketika membicarakan penelitian, seringkali Anda memerlukan perhitungan-

perhitungan statistik yang merupakan bagian penting dari ilmu statistika. 

Statistika yang digunakan dalam penelitian merupakan bagian dari statistika 

terapan. Yang akan dibahas di sini adalah bagaimana statistika terapan 

digunakan untuk keperluan praktis dalam kegiatan penelitian guru, terutama 

dari aspek penggunaan berbagai aplikasi komputer untuk perhitungan 

statistik. 

Ada dua jenis statistika terapan yang perlu dipahami, yaitu: statistika 

deskriptif dan statistika inferensial. Jenis pertama, statistika deskriptif, 

mendeskripsikan kelompok-kelompok pada suatu variabel. Statistika 



 

Kegiatan Pembelajaran 1 

 6 

deskriptif digunakan hanya untuk menggambarkan atau menganalisis suatu 

penelitian tanpa melakukan generalisasi (Gunawan, 2015). Jenis kedua, 

statistika inferensial, memungkinkan Anda untuk menginferensi hasil-hasil 

dari suatu sampel ke populasinya, artinya berdasarkan perhitungan statistik 

yang dilakukan terhadap sampel dapat ditarik kesimpulan yang lebih umum 

untuk seluruh populasi.  

Kedua jenis statistika tersebut barangkali diperlukan untuk kegiatan 

penelitian yang mungkin dilakukan guru, dan di bab ini akan dibahas berbagai 

statistik deskriptif dasar yang merupakan bagian dari pembahasan statistika 

jenis pertama, yaitu statitika deskriptif. 

Variabel Penelitian dan Skala Pengukuran 

Setiap penelitian yang dilakukan, pada dasarnya adalah meneliti variabel-

variabel. Variabel dapat berbentuk apa saja yang ditetapkan oleh peneliti. Dari 

penelitian yang dilakukan terhadap variabel ini, melalui informasi yang 

diperoleh akan ditarik kesimpulan-kesimpulan. 

Secara teoritis, variabel dapat didefinisikan sebagai atribut seseorang, atau 

objek, yang mempunyai variasi antara satu dengan yang lain atau satu objek 

yang satu dengan objek yang lain (Sugiyono, 2012, p. 38). 

Healey, mendefinisikan variabel sebagai suatu ciri atau sifat yang dapat 

berubah nilai dari kasus ke kasus (dalam Wahyudin, 2013). Misalnya, tinggi 

badan saya 150 cm, dan tinggi badan kakak saya 170 cm. Variabel “tinggi 

badan” dapat berubah dari satu kasus (tinggi badan saya) ke kasus lain (tinggi 

badan kakak saya). 

Jadi, dalam sebuah penelitian, item-item pada angket (questioner) atau survey 

merupakan variabel, begitu pula skor-skor hasil pretes atau postes. Untuk 

pengolahan dan penyajian data, selanjutnya perlu Anda kenali berbagai 

tingkat pengukuran dari variabel-variabel tersebut.  
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Variabel-variabel dalam penelitian, dikategorikan ke dalam tiga jenis skala 

pengukuran, yaitu: nominal, ordinal, dan interval-rasio (Wahyudin, 2013, p. 2). 

Nominal: Variabel-variabel nominal mengklasifikasikan kasus ke dalam 

kategori, misalnya variabel jenis kelamin dapat dibuat kategori pria atau 

wanita, kategori agama dapat dibuat kategori Muslim atau non-Muslim. Tidak 

terdapat pemberian peringkat atau urutan kategori, tidak ada operasi 

matematis yang diperbolehkan. Kategori-kategori untuk variabel nominal 

harus saling eksklusif (tiap subjek hanya masuk ke dalam satu dan hanya satu 

kategori). Contoh variabel nominal diantaranya adalah: gender, agama, 

ras/etnik, semua pertanyaan Ya/Tidak.  

Ordinal:  Variabelordinal memiliki kualitas yang sama dengan variabel 

nominal dengan kategori-kategorinya diberi peringkat (ranked) atau urutan 

(ordered) dari tinggi ke rendah. Contoh variabel ordinal diantaranya: 

peringkat di kelas, sebagian besar skala (terutama yang diukur dari “Sangat 

Setuju” ke “Sangat Tidak Setuju”).  

Interval-Rasio: Variabel ini lebih maju dibandingkan interval ordinal. Jika 

Anda akan mengelompokkan siswa di sekolah menurut peringkat/ 

rangkingnya di kelas, maka akan memperoleh ukuran ordinal. Tetapi, jika 

Anda kelompokkan siswa-siswa itu berdasarkan perolehan nilai tesnya 

misalnya, maka akan diperoleh ukuran interval-rasio.Contoh variabel interval 

rasio diantaranya: usia (dalam tahun), pendapatan (dalam rupiah), jumlah 

anak, lama jam belajar, nilai/skor ujian, dsb.   

Penyajian Data Statistik Deskriptif Dasar 

Sekarang Anda siap untuk memulai analisis data. Analisis data biasanya 

dimulai dengan mendeskripsikan distribusi suatu variabel, misalnya berapa 

persen yang berjenis kelamin laki-laki, dan seterusnya. Untuk tujuan tersebut 

biasanya Anda menggunakan statistik-statistik deskriptif dasar seperti 

persentase, rasio, rate, tabel, diagram, dan grafik. Yang akan dibahas di sini 
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adalah yang berhubungan dengan tiga hal terakhir, yaitu tabel, diagram, dan 

grafik. 

Setidaknya, ada tiga cara yang bisa dilakukan untuk menampilkan data yang 

berbentuk angka atau bilangan sebagai hasil analisa data: 

1. Menyatukannya ke dalam teks. 

2. Menampilkannya secara terpisah dalam tabel 

3. Menampilkannya dalam bentuk grafik. 

Tergantung kebutuhan dan konteksnya, ketiga cara ini bisa digunakan. Yang 

penting tujuannya tercapai, yaitu data dapat dipahami dengan mudah oleh 

pembaca dan mendukung poin yang Anda sampaikan. 

1)  Menyatukan Angka ke dalam Teks 

Anda harus membatasi jumlah angka yang ditambahkan dalam teks, sebaiknya 

tidak lebih dari tiga. Jika lebih, pertimbangkan untuk menggunakan tabel. 

Contoh: 

Penelitian yang dilakukan pada pertengahan tahun 2014 menyimpulkan bahwa 

15% guru Indonesia pernah mencoba melakukan Penelitian Tindakan Kelas.. 

Bandingkan dengan contoh berikut yang menampilkan lebih banyak data: 

Penelitian yang dilakukan pada pertengahan tahun 2014 menyimpulkan bahwa 

25% guru Indonesia pernah mencoba melakukan PTK setidaknya sekali tetapi 

tanpa publikasi, 3% pernah melakukan PTK dan hasilnya dipublikasikan, dan 

72% tidak pernah melakukan sama sekali. 

Informasi ini akan lebih efektif jika ditampilkan dalam tabel seperti berikut: 
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Tabel 1.1 Pelaksanaan Penelitian Tindakan Kelas di Kalangan Mahasiswa 

Tingkat Penggunaan Persentase 

Pernah mencoba melakukan tanpa 
publikasi 

25 

Pernah melakukan dan 
dipublikasikan 

3 

Tidak pernah sama sekali 72 

Selain itu, penting juga bagi Anda untuk mengetahui aturan bahasa dalam 

penulisan angka. Misalnya, dalam Bahasa Indonesia tidak diperkenankan 

mengawali kalimat dengan angka dan angka kecil harus ditulis dalam teks, 

tidak boleh dalam bentuk angka. 

Contoh yang salah: 

15 mahasiswa diwawancarai seputar pandangan politik mereka dan semuanya 

mengaku pernah melakukan demo, setidaknya 2 kali. 

Seharusnya: 

Lima belas mahasiswa diwawancarai seputar pandangan politik mereka dan 

semuanya mengaku pernah melakukan demo, setidaknya dua kali. 

2) Menampilkan Data ke dalam Tabel 

Jika data yang ingin ditampilkan cukup banyak, pilihan akan terbatas antara 

tabel atau grafik/diagram. Tabel bisa digunakan ketika data yang ditampilkan 

tidak terlalu banyak. Pembaca akan kesulitan untuk memahami terlalu banyak 

angka. Kondisi seperti ini lebih baik ditampilkan dalam bentuk grafik. Oleh 

karena itu, hindari juga penggunaan tabel dalam presentasi jika waktu yang 

tersedia tidak cukup bagi pendengar untuk mencerna angka-angka yang ada 

di dalamnya. 
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Tabel juga berguna jika memang Anda ingin memfokuskan perhatian pembaca 

pada angka, bukan pada perbandingannya. Jika fokus Anda pada 

perbandingannya, lebih baik menampilkan dalam bentuk grafik. 

Desain Tabel 

Untuk mempermudah keterbacaan tabel, Anda juga perlu mempertimbangkan 

desain tabel.Kebanyakan orang lebih nyaman membaca kolom daripada baris. 

Oleh karena itu, utamakan menuliskan data di kolom, bukan baris. 

Tabel 1.2 Tingkatan Peserta Versi 1 

Tingkat Peserta Jumlah 

Pemula 15 

Menengah 23 

Mahir 44 

 

Tabel 1.3 Tabel Tingkatan Peserta Versi 2 

Tingkat Peserta Pemula Menengah Mahir 

Jumlah 15 23 44 

Tabel Tingkatan Peserta Versi 1 lebih mudah dibaca daripada Tabel Tingkatan 

Peserta Versi 2. 

Pertimbangkan untuk mengurutkan data dalam tabel untuk mempermudah 

pembaca dalam memahaminya. Kriteria pengurutan bisa disesuaikan dengan 

kebutuhan, bisa berdasarkan nilai atau kategorinya. 

Tabel 1.4 Tabel Data Pekerjaan Versi 1 

Pekerjaan Jumlah  Pekerjaan Jumlah 

Pengrajin 62  Pedagang 18 

Petani 53  Pengrajin 62 
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Buruh Pabrik 42  Petani 53 

Nelayan 40  Nelayan 40 

Pedagang 18  PNS 2 

PNS 2  Buruh Pabrik 42 

Untuk tabel yang panjang, pertimbangkan untuk mengisi barisnya dengan 

warna latar bergantian untuk mempermudah pembaca memisahkan setiap 

barisnya. 

Tabel 1.5 Tabel Data Pekerjaan Versi 2 

Pekerjaan Jumlah  Pekerjaan Jumlah 

Pengrajin 62  Pedagang 18 

Petani 53  Pengrajin 62 

Buruh Pabrik 42  Petani 53 

Nelayan 40  Nelayan 40 

Pedagang 18  PNS 2 

PNS 2  Buruh Pabrik 42 

 

3) Menampilkan Data dalam Bentuk Diagram/Grafik 

Ketika data tidak mungkin ditampilkan berbarengan dengan teks dan terlalu 

rumit untuk ditampilkan sebagai tabel, maka pilihan yang logis hanyalah 

menampilkan sebagai grafik. Ada beberapa pilihan grafik yang bisa digunakan. 

Pemilihan bentuk grafik yang digunakan disesuaikan dengan jenis data 

(tingkat pengukuran variabelnya – nominal, ordinal, atau interval rasio).  

Untuk variabel-variabel tingkat nominal dan ordinal, hendaknya 

menggunakan diagram batang atau diagram lingkaran, dan untuk variabel 

interval-rasio, hendaknya menggunakan histogram atau poligon frekuensi 
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(atau diagram garis). Semua diagram dan grafik tersebut bertujuan sama, 

yaitu menjadikan distribusi variabel di sepanjang kategori-kategori itu jelas 

dan mudah dibaca.  

Misalkan Anda pun merasa bahwa data penelitian pada “Tabel Data Pekerjaan” 

itu akan lebih baik jika disajikan dalam bentuk diagram/grafik. Perhatikan 

bahwa data pada tabel itu variabelnya memiliki ukuran ordinal. Sehingga 

diagram/grafik yang tepat adalah diagram batang atau lingkaran.  

a) Diagram Batang (Clustered Column)  

Inilah tipe grafik paling populer karena alasan yang sangat jelas, mudah 

dipahami.Dalam Aktivitas 2 pada bab ini, Anda juga akan belajar cara-cara 

praktis penyajian data dalam grafik menggunakan berbagai software populer.  

b) Menampilkan Data dalam Diagram Lingkaran (Pie)   

Seperti disebutkan di atas, diagram lingkaran cocok untuk menyajikan data 

yang memiliki skala pengukuran nominal atau ordinal. Diagram ini digunakan 

untuk membandingkan antar bagian terhadap total. Diagram lingkaran ini 

cocok digunakan untuk data yang perbandingannya sedikit. Akan sangat tidak 

cocok jika data yang digunakannya memiliki banyak kategori untuk 

dibandingkan.  

Statistik Deskriptif Dasar Menggunakan Aplikasi Komputer Statistika 

Secara manual hampir dipastikan dalam proses pengolahan data, Anda akan 

menemukan berbagai rumus-rumus statistik yang rumit serta hitung-

hitungan angka yang panjang. Tentu saja, perhitungan manual untuk itu akan 

sangat menyita waktu. 

Seiring dengan kemajuan ilmu dan teknologi, kini pekerjaan-pekerjaan yang 

menyita waktu itu bisa sedikit teratasi. Berbagai perhitungan statistik yang 

panjang dan rumit itu, dapat dengan mudah dan cepat diselesaikan 

menggunakan bantuan berbagai aplikasi komputer untuk perhitungan 

statistik. Bukan saja cepat, hasil perhitungannya pun tepat dan akurat. 
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Walaupun demikian, pemahaman Anda untuk mengoperasikan program-

program itu harus ditunjang pula oleh pemahaman Anda terhadap konsep 

dasar statistikanya. 

Ada banyak program komputer yang dapat digunakan untuk keperluan 

pengolahan data statistik, diantaranya: SPSS, SAS, STATA, LISREL, MINITAB, 

AMOS, dan Eviews. Semuanya merupakan program komputer khusus statistik. 

Dapat juga dengan menggunakan Add Ins dari program lain seperti pada 

Microsoft Excell.Satu program komputer khusus statistik yang cukup populer, 

yang akan dibahas di sini adalah SPSS. 

Pengenalan SPSS  

SPSS singkatan dari Statistical Package for The Social Software. SPSS berusia 

sudah cukup tua, tahun 2018, usianya akan genap 50 tahun. Ini artinya, SPSS 

itu lebih tua dari Windows, juga lebih tua dibandingkan komputer Apple 

pertama. Pada awal kelahirannya, SPSS dijalankan pada komputer Main Frame 

menggunakan “punch card” (McCormick, 2015, p. 10). 

SPSS dikembangkan pertama kali oleh Norman H. Nie, C. Hadlai (Tex) Hull, dan 

Dale H. Bent di Universitas Standford di akhir tahun 1960-an. Mereka akan 

menganalisis data dalam jumlah besar dalam bidang ilmu sosial, sehingga 

dikembangkanlah software Statistical Package for Social Sciences (SPSS). SPSS 

pertama kali muncul dalam untuk versi PC dengan nama SPSS/PC+ (versi 

DOS). Setelah populernya Windows maka SPSS dikembangkan mulai versi 6.0 

hingga sekarang. 

Sejak Juli 2009, SPSS disebut sebagai PASW (Predictive Analytic Software), dan 

sejak 2010 namanya berubah menjadi IBM SPSS (Statistical Product and 

Service Solutions) yang sepenuhnya telah diintegrasikan ke dalam IBM 

Corporation. Versi tebaru SPSS (2015) bernama IBM SPSS Statistics 23.0.   
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D. Aktivitas Pembelajaran 

Aktivitas 1: Menyajikan Data dalam Bentuk Tabel 

Misalkan Anda adalah guru matematika yang menghadapi masalah terkait 

pembelajaran matematika di kelas. Untuk mengatasinya, Anda mencoba 

melakukan sebuah Penelitian Tindakan Kelas dengan menerapkan sebuah 

model pembelajaran baru di kelas, karena Anda menganggap itu akan menjadi 

solusi terhadap masalah Anda. Di akhir pembelajaran, Anda mengumpulkan 

data tentang sikap siswa terhadap model pembelajaran yang dilakukan.  

Langkah pertama dalam menganalisis data yang diperoleh adalah dengan 

membuat tabel distribusi frekuensi seperti di bawah ini. 

Tabel 1.6 Sikap Terhadap Model Pembelajaran 

Sikap f 

Setuju Sekali 5 

Setuju  20 

Ragu-ragu 8 

Tidak Setuju 5 

Sangat Tidak Setuju 2 

Berikut ini adalah tutorial singkat bagaimana membuat tabel distribusi 

menggunakan aplikasi populer, yaitu Microsoft Words. 
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Langkah 1 

Buka tab Insert lalu klik ikon tabel. Ketika diklik, akan muncul deretan kotak-

kotak kecil yang mewakili kolom dan baris yang dihasilkan. Pilih susunan 

kolom dan baris yang Anda inginkan. Dalam contoh di bawah, dipilih tabel 

berukuran 3 kolom dan 6 baris. 

 

Cara pengisian tabel sama seperti proses input biasa. Anda juga bisa mengatur 

lebar kolom sesuai keperluan dengan menggunakan mouse. 

Langkah 2 

Anda bisa mengatur sendiri tampilan tabel, namun lebih disarankan untuk 

memulai dari Styles di Table Tools > Tab Design. Pilih salah satu style yang 

tersedia lalu ubah propertinya jika diperlukan. Aktifkan Header Row dan 

First Column untuk memberi kontras pada kolom pertama dan baris teratas. 

Aktifkan Banded Rows untuk memisahkan tampilan baris genap dan ganjil. 
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Ekspor Tabel dari Microsoft Excell 

Untuk data yang lebih rumit, kemungkinan besar Andaakan memprosesnya di 

Microsoft Excell. Untuk mengekspornya ke Word, pilih terlebih dahulu sel 

berisi data yang akan diambil. Tekan Ctrl + C untuk menyimpannya ke 

clipboard. 

 

Kembali ke Word, tekan Ctrl + V untuk langsung mengeluarkan data dari 

clipboard. Untuk melihat pilihan lainnya, Anda bisa klik kanan. Pada bagian 
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Paste Option  terdapat banyak pilihan, di antaranya menampilkan data dalam 

teks atau gambar. 

 

Anda juga bisa menampilkan membuka pilihan Paste lainnya dan memilih 

Paste Special, dan Anda bisa memilih untuk menampilkan data sebagai objek 

Microsoft Excell. 

 

Menggunakan pilihan ini, Anda memasukkan data dalam format Excell ke 

dalam Word. Ketika mengedit data dengan cara klik ganda, Anda masih bisa 

menggunakan semua fitur canggih yang tersedia di Excell. 
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Aktivitas 2: Menyajikan Data Dalam Bentuk Diagram/Grafik Batang 

Selanjutnya akan diperlihatkan cara membuat diagram batang untuk data 

pada Tabel berikut. Ikuti langkah-langkah berikut untuk memahami proses 

kerjanya. 

Tabel 1.7 Sikap Terhadap Model Pembelajaran 

Sikap Terhadap Model Pembelajaran 
Jumlah 

Laki-laki Perempuan 

Setuju Sekali 3 2 

Setuju  8 12 

Ragu-ragu 4 4 

Tidak Setuju 3 2 

Sangat Tidak Setuju 1 1 
 

Langkah 1 

Di tab Insert, klik ikon Chart. 
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Dari pilihan yang muncul, pilih Column untuk membuat grafik batang yang 

berbentuk vertikal., dan pilih Bar jika Anda ingin grafik batang berbentuk 

horizontal. Grafik batang populer karena bisa digunakan untuk berbagai jenis 

data (khususnya. yang jenis pengukurannya nominal dan ordinal) dan mudah 

dipahami pembaca. Klik OK. 

 

Selanjutnya akan diperlihatkan grafik batang beserta contoh data yang 

digunakan dalam tampilan spreadsheet Excell. Tabel ini bersifat dinamis, 

otomatis berubah ketika datanya dimodifikasi. Dalam gambar di bawah, 

perhatikan tinggi Category 1 langsung berubah ketika angka dalam 

spreadsheet diubah. 
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Langkah 2 

Di spreadsheet, isikan data yang akan digunakan. 

 

Data yang digunakan dalam grafik berada dalam garis-garis tabel. Data di 

Tabel 1.6, Anda hanya menggunakan 2 kolom dan 5 baris data. Dengan mouse, 

klik dan geser pojok garis pembatas untuk membatasi data yang dimaksud. 

Bentuk grafik pun akan otomatis diperbarui mengikuti data yang digunakan. 

 

Selanjutnya, hapus isi spreadsheet yang tidak digunakan. 
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Simpan kursor di pojok kanan bawah grafik lalu klik dan geser untuk 

mengubah ukurannya. Bentuk grafik dan teksnya akan diperbarui secara 

otomatis mengikuti ukuran grafik. Klik grafik untuk memilihnya.  

Langkah 3 

Di sisi kanan, Anda bisa melihat beberapa ikon untuk pengaturan tambahan. 

Klik ikon plus,+> Axes untuk mengatur sumbu dalam grafik. Kosongkan 

pilihan untuk menyembunyikan dan sebaliknya untuk menampilkan. Dalam 

contoh di bawah, sumbu vertikal x disembunyikan. 

Dari pilihan Axis Titles, bisa ditambahkan judul sumbu. 

 

Cara mengubah teks judul, klik saja kotak teksnya.Dari pilihan Chart Title, 

bisa ditambahkan judul grafik. 

Agar lebih mudah dibaca, Anda bisa menambahkan keterangan data pada 

grafik. Klik ikon plus, +> Data Labels. 

Silakan mengeksplorasi pilihan-pilihan yang tersedia untuk memperbaiki 

tampilan grafik. Anda bisa mengubah style grafik termasuk kombinasi warna 

yang ingin digunakan untuk tampilan grafik Anda pada pilihan Style dan 

Color.  Hilangkan tanda cek untuk menonaktifkan fitur.  
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Jika ada data tertentu yang ingin disembunyikan, hilangkan kotak cek di depan 

namanya lalu klik Apply jika sudah merasa pengaturannya sudah cukup. 

Aktivitas 3: Menyajikan Data Dalam Bentuk Diagram Pie 

Langkah pembuatannya hampir mirip dengan pembuatan diagram batang. 

Mulai dengan klik tab Insert > Chart, dan pilih Pie lalu klik Ok. Kemudian 

masukkan data yang Anda ingin tampilkan ke dalam spreadsheet yang tesedia. 

Buat pengaturan untuk judul, label, style, dan warna seperti pada pengaturan 

menggambar diagram batang di atas. Untuk menampilkan nilai dalam bentuk 

persentase pada diagram, lakukan pengaturan berikut: Pilih CHART 

ELEMENT (tanda + di bagian kanan atas) dengan cara klik pada area diagram, 

lalu pilih Data Labels dan klik panah lalu klik More Options. 
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Untuk sajian akhir, pastikan melakukan pengaturan untuk membubuhkan 

nilai persentase pada diagram.  

Pastikan membubuhkan tanda centang pada pilihan Percentage, dan pilih 

Label Position > Outside End jika ingin menempatkan nilai persentase itu di 

luar area diagram agar terlihat lebih jelas. 

 

Inilah tampilan akhir diagram lingkaran yang Anda inginkan. 
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Contoh interpretasi yang dapat Anda buat dalam bentuk narasi untuk data 

pada grafik di atas misalnya, “Siswa yang setuju dengan penerapan model baru 

dalam pembelajaran memiliki porsi terbesar dibandingkan dengan yang 

respon lainnya, yaitu sebanyak 50%. Interpretasi lain yang dapat Anda buat 

terkait data yang tersaji dalam diagram di atas misalnya, Anda dapat 

mengatakan bahwa siswa yang bersikap positif terhadap penerapan model 

pembelajaran baru di kelas Anda ada sebanyak 62,5%,  yang sikapnya netral 

ada 20%, dan yang memandang negatif sebanyak 17,5%. Artinya, dari 40 

siswa mengikuti pembelajaran dengan model baru ada 25 orang (62,5% dari 

40 orang), dan begitu seterusnya. Interpretasi-interpretasi itu perlu Anda 

utarakan untuk menjelaskan data yang Anda sajikan. 

Aktivitas 4: Analisis Data Statistik Deskriptif Menggunakan SPSS 

1) Memulai SPSS 

Pertama, pastikan bahwa program SPSS telah terinstal di komputer Anda. Jika 

sistem operasi komputer yang digunakan adalah Windows, maka SPSS yang 

digunakan adalah SPSS for Windows, sehingga untuk memulai program SPSS 

bisa dimulai dari menu Start. 
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 Klik Start > Program > IBM SPSS Statistics > IBM Statistics 21. Jika 

sebelumnya Anda sudah menyimpan shortcut di desktop atau pada list di 

Star Menu atau Taskbar, membuka program ini menjadi lebih cepat. 

 Pada menu SPSS versi 21 ketika pertama kali membuka program akan 

muncul jendela sebagai berikut, 

 

Anda bisa menutup jendela itu dengan cara klik tombol close (x) berwarna 

merahdi ujung kanan atas atau pilih tombol Cancel. Pastikan Anda memberi 

tanda centang pada pilihan Don’t show this dialogue in the future jika 

tidak ingin melihat jendela itu lagi setiap kali membuka program ini. 

 Layar pertama yang terbuka bernama “Untitled 1 [DataSet0] – IBM SPSS 

Statistics Data Editor”. Layar ini dinamakan Jendela Data Editor. Berikut 

adalah jendela Data Editor yang masih kosong karena belum dimasukkan 

data. 
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Jendela Data Editor di atas mempunyai dua tampilan, yaitu Data View dan 

Variable View. Data View akan menampilkan data base dalam bentuk angka, 

di sinilah nanti data akan diinput. Variable View menampilkan keterangan 

tentang variabel yang terdiri dari: Name, Type, Width, Decimals, Label, Values, 

Missing, Column, Align, Measure, dan Role. 

2) Menginput Data dan Memberi Nama Variabel 

Pada latihan ini, Anda akan memasukkan data Berat badan 10 orang siswa 

yang terdiri dari 3 laki-laki dan 7 perempuan. 

Ada dua tahap dalam input data di SPSS. Pertama, mendefinisikan variabel. 

Kedua, memasukkan data. 

Pertama, kita definisikan terlebih dahulu variabel yang digunakan. Ada tiga 

variabel yang kita butuhkan dalam data setiap siswa, yaitu namanya, jenis 

kelaminnya, dan berat badannya. 

Di bagian bawah, klik tab Variabel View untuk memasuki jendela Variabel 

View. 
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Di jendela Variable View masukkan data sebagai berikut: 

 

Pengaturan penting yang perlu Anda perhatikan diantaranya: 

Isi kolom Name dengan variabel Nama, Jenis_Kelamin, dan Berat Badan. 

Variabel pada kolom Name harus diawali dengan huruf dan tidak boleh 

memiliki spasi (space bar). Pada kolom Type, Nama dan Jenis_Kelamin diisi 

dengan String –artinya variabel berupa teks, sementara Berat_Badan dengan 

Numeric –artinya variabel berupa angka. Di kolom Label,Anda bisa 

memberikan keterangan dan penjelasan lebih detail tentang variabel. 

Variabel Jenis_Kelamin terbagi dua kategori, maka atur Value untuk memberi 

dua kode agar input data menjadi lebih mudah, misalnya “1” untuk laki-laki 

dan “2” untuk perempuan. Maka, ketika input, cukup dimasukkan angka 1 

untuk laki-laki atau 2 untuk perempuan. Di pilihan Align dapat diatur apakah 

ingin rata kiri, rata kanan, atau di tengah. Measure untuk Berat_Badan diisi 

dengan Scale (untuk pengukuran, misalnya 5 kg atau 6,5 kg), sementara yang 

lainnya dengan Nominal. Untuk pengaturan lain cukup dibiarkan seperti 

bawaan standarnya. 

Kedua, menginput data. Klik tab Data View di pojok kiri bawah. Selanjutnya, 

Anda tinggal menuliskan datanya. Untuk nama tinggal menuliskan teksnya. 

Untuk jenis kelamin, dituliskan 1 untuk laki-laki dan 2 untuk perempuan. 

Untuk berat badan, nilainya otomatis ditampilkan dengan dua digit belakang 

koma. 
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3) Menampilkan dan Memanipulasi Output 

Selain jendela Data Editor, dilengkapi pula Jendela “SPSS Output”. Jendela IBM 

SPSS Statistics Viewer  akan menampilkan hasil-hasil analisis statistik dan 

grafik yang Anda buat. Kita bisa menyebutnya dengan sebutan Jendela 

Output. 

1) Analisa Statistika Deskriptif 

Kita akan melakukan analisis sederhana statistik deskriptif lainnya 

menggunakan SPSS. Kita akan mempraktekan perhitungan statistik 

menggunakan data nilai 12 murid. Variabel yang digunakan dalam data ini 

adalah inisial nama murid dan nilainya. Data sudah tersimpan dalam file 

Excell. Kita akan mengimpor data ke SPSS lalu melakukan perhitungan 

sederhana statistika deskriptif. 



 

Modul Diklat  Guru Pembelajar  

 

 29 

 

SPSS cukup baik dalam menangani data dari Excell. Bahkan, Anda praktis tidak 

perlu melakukan modifikasi apa pun pada file Excell. Di SPSS, klik Open > 

Data. Dari daftar Files of Type, pilih tipe file Excell (*.xls). Pilih file Excell yang 

diinginkan dan klik tombol Open. 
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Aktifkan Read variabel names from the first row of data untuk menjadikan 

baris pertama sebagai variabel. Dalam contoh ini, Inisial dan Nilai Akhir 

otomatis dijadikan variabel. Secara otomatis, SPSS akan mendeteksi sel-sel 

yang berisi data. Dalam kasus ini, sel yang bisa diimpor berada di Sheet 1 mulai 

dari sel A1 hingga B13. Klik tombol OK. 

 

Berikut adalah tampilan data-data yang telah diimpor ke SPSS. Perhatikan 

bahwa kolom Nilai Akhir diubah menjadi variabel NilaiAkhir karena variabel 

tidak boleh memiliki spasi. 

 

Periksa variabel-variabel hasil impor otomatis di jendela Variabel View. 

Tambahkan label dan pastikan type yang digunakan sudah tepat. Di contoh ini, 

nama variabel NilaiAkhir dipersingkat menjadi Nilai. 
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Untuk menghitung statistika deskriptif, klik Analyze > Descriptive Statistics 

> Descriptives. 

 

Variabel yang akan kita hitung adalah nilai murid (bukan inisial murid 

tentunya), sehingga logis untuk memilih variabel Nilai. 

 

Klik tombol Options dan pilih perhitungan yang ingin Anda lakukan, setelah 

selesai klik OK. 
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Tunggu beberapa saat agar SPSS melakukan perhitungan. Hasilnya akan 

ditampilkan dalam bentuk tabel seperti terlihat di bawah. 

 

Distribusi Frekuensi 

Kita juga bisa mempresentasikan data dalam bentuk tabel distribusi frekuensi. 

Untuk mempermudah penjelasan distribusi frekuensi, kita akan langsung 

praktek menggunakan data yang sama seperti di atas, yaitu nilai 12 siswa. 

Klik Analyze >Descriptive Statistics > Frequencies. 
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Di kotak dialog yang muncul, masukkan variabel Nilai. Klik tombol Statistics 

untuk menentukan perhitungan yang akan dilakukan. Klik tombol Continue. 

 

Untuk menambahkan grafik, klik tombol Chart lalu pilih salah satu tipe tabel 

yang ingin ditampilkan. Umumnya tabel yang sering digunakan adalah 

Histogram. Aktifkan juga Show normal curve on histogram untuk 

menambahkan grafik kurva normal di atas histogram. 
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Format tampilan tabel distribusi frekuensi juga bisa diatur. Klik tombol 

Format. Di sini dipilih Descending Values, artinya data diurutkan dari nilai 

besar ke kecil. 

 

Klik tombol OK di kotak dialog Frequencies agar SPSS memulai perhitungan. 

Di bawah adalah tampilan tabel distribusi frekuensi yang dihasilkan SPSS. 
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Kolom kiri menyatakan nama statistik dan kolom kanan adalah nilainya. 

Misalnya N Valid menyatakan ada 12 data valid dan N Missing berarti tidak 

ada data yang hilang. Mean data ini adalah 79,5842. Nilai kurtosis negatif 

 ,122  maka distribusi data “melandai”, artinya varians besar. Data yang 

berdistribusi normal idealnya memiliki nilai kurtosis (dan skewness) nol . 

Di bawah adalah tabel distribusi frekuensi data. Data diurutkan dari nilai 

terkecil ke terbesar. Di baris pertama, dinyatakan bahwa nilai 67,22 muncul 

sekali (Frekuensi: 1) atau 8,3% dari total data. Kolom terakhir menunjukkan 

persentase kumulatif data, yang terus bertambah hingga seluruhnya akan 

berjumlah 100%. 

 

Dan berikut tampilan data dalam histogram. 
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Tampilan histogram ini masih bisa diubah. Klik ganda untuk memunculkan 

kotak dialog Chart Editor. Klik ganda histogram untuk mengubah ukurannya 

di kotak dialog Properties. 

 

Jika batang histogram diklik ganda, Properties menampilkan settingnya. 

Warna dan garisnya bisa diubah. 
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Bagian lain dari tabel bisa diubah dengan cara diklik ganda lalu diberi setting 

baru di Properties. 

Aktivitas 5:  

Dalam sebuah penelitian, seringkali kita dituntut untuk dapat menyajikan data 

hasil penelitian sehingga data itu mudah dipahami termasuk oleh pembaca 

yang bukan peneliti. Dari suatu hasil penelitian (bisa penelitian sendiri atau 

orang lain),  pilihlah sebuah data, kemudian sajikan data tersebut ke dalam 

bentuk tabel, diagram atau grafik yang sesuai, menggunakan program 

Microsoft Office yang Anda miliki (Word, Excell, atau PowerPoint). Buatlah 

deskripsi atau interpretasi untuk data yang Anda sajikan itu.  

Dengan mengikuti langkah-langkah seperti yang sudah Anda lakukan dalam 

Aktivitas Pembelajaran, lakukan analisis statistik deskriptif untuk variabel-

variabel yang muncul pada data yang Anda miliki menggunakan program 

SPSS. 

E. Latihan/Kasus/Tugas 

Latihan 1 

Seorang guru matematika SMA melakukan sebuah Penelitian Tindakan Kelas 

(PTK) pada kelas yang terdiri dari 36 siswa, yang dilakukan dalam tiga siklus 

penelitian. Hasil penelitian, setelah diolah dirangkum sebagai berikut:  

“Nilai rata-rata kelas pada siklus I, II, dan III dalam skala 100 berturut-turut 

adalah 74,48, 79,44, dan 83,16. Sementara itu, ketuntasan belajar klasikal siklus 

I sebesar 58,33%  dengan 15 orang siswa yang tidak tuntas, kemudian pada 

siklus II ketuntasan belajar klasikal meningkat menjadi 77,78% dengan 8 orang 

siswa yang tidak tuntas dan ketuntasan belajar klasikal mengalami 

peningkatan lagi pada siklus III menjadi 86,11% dengan 5 orang siswa yang 

tidak tuntas. Sedangkan dayaserap siswa yang pada siklus I sebesar 74,48% , 

pada siklus II meningkat menjadi 79,44% dan daya serap siswa kembali 

meningkat di siklus III menjadi 83,16%. Dalam catatan penelitian disebutkan 
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bahwa target pencapaian daya serap yang diharapkan pada penelitian ini 

adalah minimal 80%. ” 

Berdasarkan informasi di atas, sajikan data hasil penelitian tersebut ke dalam 

bentuk tabel dan grafik.  

Latihan 2 

Berikut ini adalah data0 skor kemampuan penalaran matematis 30 orang 

siswa dalam sebuah penelitian. 

Siswa 
Penalaran  

Siswa 
Penalaran 

Pretest Posttest  Pretest Postest 

1 8 29  16 8 26 

2 7 31  17 8 17 

3 7 25  18 7 28 

4 12 38  19 6 31 

5 2 24  20 8 31 

6 5 26  21 8 32 

7 8 22  22 7 28 

8 2 29  23 8 30 

9 7 20  24 5 28 

10 7 25  25 8 28 

11 9 29  26 2 18 

12 8 16  27 1 17 

13 8 24  28 5 24 

14 7 23  29 8 22 

15 8 18  30 8 21 

Dengan menggunakan SPSS, lakukan analisis statistik deskriptif untuk data 

tersebut. 
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F. Rangkuman 

 Statistika yang digunakan dalam penelitian merupakan bagian dari 

statistika terapan. Ada dua jenis statistika terapan yang perlu dipahami, 

yaitu: statistika deskriptif dan statistika inferensial. 

 Statistika deskriptif adalah statistika yang digunakan untuk 

menggambarkan atau menganalisis suatu penelitian tanpa melakukan 

generalisasi, 

 Statistika inferensial adalah statistika yang digunakan untuk menganalisis 

data sampel untuk melakukan inferensi terhadap populasi. 

 Setiap penelitian yang dilakukan, pada dasarnya adalah meneliti variabel-

variabel. Dari penelitian yang dilakukan terhadap variabel ini, melalui 

informasi yang diperoleh akan ditarik kesimpulan-kesimpulan. 

 Variabel dikategorikan ke dalam tiga jenis skala pengukuran, yaitu: 

nominal, ordinal, dan interval-rasio. 

 Macam statistik deskriptif dasar: persentase, rasio, rate, tabel, diagram, 

dan grafik.  Data statistik deskriptif dapat disajikan menggunakan 

berbagai aplikasi komputer populer dari Microsoft Office (Words, Excell, 

PowerPoint) atau aplikasi khusus statistik seperti SPSS.   

G. Umpan Balik dan Tindak Lanjut 

Untuk mengukur ketercapaian kompetensi Anda dalam mempelajari bahan 

belajar ini, diharapkan dapat mengukur kemampuannya dengan dengan 

mengerjakan soal atau permasalahan yang disajikan pada Latihan. Jika Anda 

masih kesulitan untuk menyelesaikan soal yang diberikan, Anda bisa kembali 

membaca materi pada kegiatan pembelajaran dan mengikuti langkah-langkah 

tutorial yang ada pada masing-masing aktivitas pembelajaran.    
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Anda dapat mencocokkan jawaban yang Anda kerjakan dengan alternatif 

jawaban yang diberikan pada Kunci Jawaban. Jika jawaban Anda sudah sesuai 

maka Anda sudah menguasai materi ini dan dapat melanjutkan ke materi 

berikutnya. Jika belum dapat menyelesaikan seluruhnya, ulangi membaca 

materi dan berlatihlah kembali untuk memahami semua materi yang 

disampaikan.  

H. Kunci Jawaban 

Berikut ini adalah alternatif jawaban soal latihan. 

Latihan 1 

Data dapat disajikan dalam bentuk tabel sebagai berikut: 

Tabel 1.8 Hasil Belajar Siswa Tiap Siklus 

Siklus 
Nilai 
Rata-
Rata 

Jumlah 
Siswa 

Tuntas 
Belajar 

Ketuntasan 
Belajar 
Klasikal 

Daya 
Serap 

Keterangan 

I 74,48 21 58,33% 74,48% 
Belum 

Tercapai 

II 79,44 28 77,78% 79,44% 
Belum 

Tercapai 

III 83,16 31 86,11% 83,16% Tercapai 

 

Data pada tabel tersebut dapat pula disajikan dalam bentuk grafik/diagram 

sebagai berikut. 
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Latihan 2 

Melalui perintah Analyze > Descriptive Statistics > Frequencies, dan pada 

pilihan Statistics, beri centang pada bagianMean, Std. deviation, Variance, 

Minimum, Maximum, dan Kurtosis, diperoleh hasil sebagai berikut. 

Statistics 

 Pretest Postest 

N 

Valid 30 30 

Missing 0 0 

Mean 6.7333 25.3333 

Std. Deviation 2.37709 5.27410 

Variance 5.651 27.816 

Kurtosis 1.237 -.240 

Std. Error of Kurtosis .833 .833 

Minimum 1.00 16.00 

Maximum 12.00 38.00 

Sementara jika melalui perintah Analyze > Descriptive Statistics > 

Descriptives, dan pada pilihan Options, beri centang pada bagianMean, Std. 

deviation, Variance, Minimum, Maximum, dan Kurtosis, diperoleh hasil 

sebagai berikut. 

Descriptive Statistics 

 

 N Minimum Maximum Mean Std. 
Deviation 

Variance Kurtosis 

Statistic Statistic Statistic Statistic Statistic Statistic Statistic Std. 
Error 

Pretest 30 1.00 12.00 6.7333 2.37709 5.651 1.237 .833 

Postest 30 16.00 38.00 25.3333 5.27410 27.816 -.240 .833 

Valid N 
(listwise) 

30        
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I. Evaluasi 

1. Statistika yang digunakan hanya untuk menggambarkan suatu hasil 

penelitian tanpa melakukan generalisasi disebut .... 

A. Statistika deskriptif 

B. Statistika inferensial 

C. Statistika teoritik 

D. Statistika matematika 

E. Statistika terapan 

2. Angket yang jawabannya berupa rentang dari “Sangat Senang”  sampai 

“Sangat Tidak Senang”, datanya menggunakan skala pengkuran .... 

A. Ordinal 

B. Nominal 

C. Interval 

D. Rasio 

E. Interval-Rasio 

3. Pilihan pada Menu Illustration di Ms Words yang dapat digunakan untuk 

menyajikan data dalam bentuk grafik/diagram adalah .... 

A. Pictures 

B. Online Pictures 

C. Shapes 

D. Smart Art 

E. Chart 

4. Aplikasi statistika yang dapat digunakan untuk menganalisis data kecuali 

..... 

A. SPSS 

B. PSPP 

C. MINITAB 

D. MATLAB 

E. LISREL 
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5. Langkah yang dapat ditempuh untuk menyajikan histogram seperti 

gambar berikut dimunculkan dengan cara memilih .... 

 

A. Analyze > Descriptive Statistics > Frequencies 

B. Analyze> Descriptive Statistics > Frequencies > Chart 

C. Graphs > Chart Builder > Element Properties 

D. Graphs > Graphboard Template Chooser > Basic > Histogram 

E. Graphs > Legacy Dialogs > Histogram 

Kunci Jawaban Evaluasi 

1. A 

2. B 

3. E 

4. D 

5. B 
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